
Consider the following questions as you decide how to implement scanning at your site.

Why/When Scan?  

• Scanning provides students with independent access to printed material for reading as well as access to writing and 
studying tools. 

What is Scanned?  

• You need to decide what needs to be scanned vs. what is nice to have scanned. 

Which Scanner? 

• There are low or high-speed scanners on the market with different features such as flat bed versus sheet feeder.

• Low speed flatbed scanners are inexpensive and can b

• Kurzweil maintains a listing of compatible scanners on its web site. Check the list if you are considering purchase of a 
new scanner. (HP, Canon, Epson, Fujitsu, etc.)

• Check to see if your copy machine is networked and if it scans 
copier to scan files and send to a computer and convert to .kes using the professional version of Kurzweil 3000. 

Where is Scanning Done? 

• Resource room, library, teacher office, computer lab, or IT o
computer affects who can scan materials.

Who Scans? 

• A teacher does not necessarily have to do the scanning. Other options include: volunteers, teaching assistants, 
volunteer and paid student workers, National Honor Society members, Computer Club members, and the students 
using Kurzweil 3000. 

• There are companies that will offer scanning as a fee
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Step 1: Scan  

Each time you scan a page; Kurzweil 3000 recognizes
process is called optical character recognition
and then creates underlying text that is read by Kurzweil 3000.

The format and/or condition of the print materials determines how well Kurzweil 3000 can interpret and read the scanned 
image.  Original documents with simple fonts produce the best results.

Step 2: Proof, Edit and Save 

Once a document is scanned, the next step is to proof it for reading order and recognition errors. Adjust the reading order 
if needed, fix any recognition errors, and save the changed document. 

Step 3: Distribution 

Distribute the file using removable media such as CD
folder on your network. 

Kurzweil 3000 files are just FILES.  They can be sa ved, deleted, moved around like any other file. 

NOTE: Instructor will demonstrate the basics of:

1. Scanning 

2. Zone Editing 

3. Optical Character Recognition

The Hands-On scanning activities on the following pages can be u sed for self
specifically requested for in- class instruction. 

recognizes or interprets the data from the scanner. This complex recognition 
optical character recognition (OCR). The OCR process first generates an image or picture of the page 

derlying text that is read by Kurzweil 3000. 

The format and/or condition of the print materials determines how well Kurzweil 3000 can interpret and read the scanned 
image.  Original documents with simple fonts produce the best results. 

Once a document is scanned, the next step is to proof it for reading order and recognition errors. Adjust the reading order 
if needed, fix any recognition errors, and save the changed document.  

able media such as CD-R, USB keychain drives, or Zip disks, or copy the file to a shared 

Kurzweil 3000 files are just FILES.  They can be sa ved, deleted, moved around like any other file. 
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Optical Character Recognition  

scanning activities on the following pages can be u sed for self -study at home, unless 
class instruction.  

 

interprets the data from the scanner. This complex recognition 
(OCR). The OCR process first generates an image or picture of the page 

The format and/or condition of the print materials determines how well Kurzweil 3000 can interpret and read the scanned 

Once a document is scanned, the next step is to proof it for reading order and recognition errors. Adjust the reading order 

R, USB keychain drives, or Zip disks, or copy the file to a shared 
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Scanning requires Kurzweil 3000 PROFESSIONAL. Kurzweil 3000 LearnStation will not have 
the Scan menu or the Scan button on the main toolbar.
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Recommended Steps for Scanning and Editing with Win  Version 12 

Step  What  How Why 
1 Prepare 

textbook/novel – 
chop binding.  

• Have binding chopped off 
at Staples/Office Supply 
copier store… 

• After scanning: 3 hole 
punch or spiral bind 

• Saves time – allows you to use 
Automatic Document Feeder 
(ADF) scanner 

• So pages are straight on flat bed 
scanner. 

2 Set up and test 
scanning options and 
recognition results for 
3-5 sample/test 
pages. 

Scan Menu and Tools, 
Options, Scanning 
• Select scanner and set 

page size 
• Decide on B/W or color 
• Scan using default settings 

and check results with 
Ranked Spelling 

• Adjust brightness, dynamic 
threshold, etc 

• Use Thumbnail view to 
see pages 

• Saves scanning time (page size) 
 
• Check results before scanning 

many pages 
 
• Improves recognition and saves 

editing time 

3 Scan and save one 
chapter at a time 

• Save each chapter 
separately 

• Use consistent file name 
convention that matches 
print textbook 

 

• Easier access by chapter 
 
• Makes it clear which file and 

chapter to open 

4 Zone edit and edit 
headers and footers 

• Scan menu - Zone Editor 
• Scan menu - 

Header/Footer Editor 

• Adjust reading order to help 
focus on important text vs. 
secondary text 

• Eliminate reading of unimportant 
information…headers /footers 

• Improves reading flow for novels 

5 Correct recognition 
errors 

• Tools Menu - Ranked 
Spelling 

• Tools Menu - Spell 
Checking 

• Edit Menu - Correct 
Recognition, Edit 
Underlying Text 

• Words are read aloud correctly 

6 Set Page Numbers 
and Page View 

For the file - View Menu – 
Page, Set Number 
For each page - View Menu  
1. Fit to …select option 
2. Page View, Remember 
3. Save file 

• File page numbers match book 
page numbers 

 
• Consistent view/zoom 

percentage for each page in file. 

7 Save Changes and 
make backup copy 
 

Place in shared network folder 
– permissions:  
• teachers to read and write 
• students to read 

 

8 Merging or dividing 
files 

File – Join will join two files 
File – Save Page Range will 
let you save a subset to 
another file 

• Allows you to adjust files that 
might not be aligned to chapters, 
section breaks 

 

 



Step 1: Scan Menu

� Insert, Delete and 
Rescan Pages

� Color or Black and White

� Double Sided 

� Two Page Mode

� Scan Repeatedly

� Scanner Setup

� Zone Editor

� Header/Footer Editor

 

Use the Scan menu to: 

• Insert , delete  or rescan  a page in the current scanned document. 

• Select color  scanning versus the default of black and white. You can change between color or 
black and white for each page in the document.  Color scanning involves more processing so it 
takes longer and generates a larger file.  

Note:  Color scanning is only available in Kurzweil 3000 Professional Color edition. 

• Double Sided  handles scanning in double-sided originals using a non-duplex scanner with 
automatic document feeder or a duplex scanner with an automatic document feeder. 

• Two Page Mode lets you scan two small facing pages at one time and then display them as two 
separate pages. If you are scanning in small-size books, this feature speeds up the scanning 
process.  

Note:  Two-page mode is enabled for Black and White scanning and not for color scanning. 

• Scan Repeatedly  lets you place pages on the scanner in timed intervals. You set the time interval 
in the Tools, Options, Scan  section. 

• Scanner Setup allows you to specify which scanner you will use if you have a system with 
multiple scanners. It also provides a Scanner Optimization feature that establishes the 
recommended settings for a document based on a sample page. 

• Zone editing  allows you to specify how Kurzweil 3000 handles blocks of text, or zones, in an 
image document. If you are a teacher, you can use zone editing to change the order in which 
portions of text are read, or to eliminate some portions.  

• Heading/Footer Editor allows you to mark an area of the document and apply the marked area to 
all pages so the content is not read. 



Step 1: Scanning Options  

▰ Find Columns

▰ Despeckle

▰ Brightness

▰ Repeated Scan 
Delay

▰ Page Orientation 

▰ OCR Engines

▰ OCR Languages 

 

The Scanning Options section provides features to improve the recognition quality for different types of 
materials such as newspapers, or pages with white type on black or dark backgrounds or foreign language 
text. 

• Find Columns is used for pages that have more than one column of text such as newspapers 
and magazines.  

• Despeckle helps Kurzweil 3000 recognize text on pages with small, colored dots or speckled 
paper (such as newspapers).  

• The Brightness setting lets you adjust the brightness of your scanner. A lower value results in 
darker scanned images and a higher value results in lighter scanned images. Try adjusting 
brightness if you are finding numerous OCR errors. 

• Repeated Scan Delay is where you set the delay time between scans in the repeated scan 
mode. 

• Page orientation lets you specify how pages are placed on the scanner glass. Kurzweil 3000 can 
automatically detect the page orientation or you can make recognition faster by specifying the 
page orientation. 

• Kurzweil 3000 comes with three OCR engines. Each engine provides a different level of 
recognition accuracy and speed. Each engine also provides a different group of recognition 
languages.  

• You would change the OCR Language when you are scanning in foreign language documents. 



Hands-On Practice - Scanning

Follow these steps to scan, delete and insert pages using the sample scanning pages on127

1. Before starting to scan in printed materials, use the 
Windows  menu option to close all open document windows. 

2. Check that the Scan  button 

3. Place the Summary of Research Front page
scanner. 

4. Click the Scan  button and notice the processing messages displayed in the 
status bar during the scanning process.

5. When the scan is complete, click the 
and select height  to view the page content.   

Your results should look similar to the following screen:

6. Next place the Summary of 
Appendices section) face down on the scanner and click the 

7. Note :  Kurzweil 3000 automatically adds the newly scanned page to the end of 
your current document.  

 

 

 

 Hands-On Practice - Scanning, Continued

Scanning  

Follow these steps to scan, delete and insert pages using the sample scanning pages on127-131. 

Before starting to scan in printed materials, use the Windows, Close, All 
ion to close all open document windows.  

 

 displays on the Main toolbar.  

Summary of Research Front page  (Page 128) face down on the 

button and notice the processing messages displayed in the 
status bar during the scanning process. 

When the scan is complete, click the zoom %  arrow 
to view the page content.    

Your results should look similar to the following screen: 

 

 

 

 

Summary of Research Table of Contents  page (Page 129 in 
Appendices section) face down on the scanner and click the Scan  button.

Kurzweil 3000 automatically adds the newly scanned page to the end of 

Scanning, Continued  

131.  

Windows, Close, All 

(Page 128) face down on the 

button and notice the processing messages displayed in the 

 

(Page 129 in 
button. 

Kurzweil 3000 automatically adds the newly scanned page to the end of 



8. Click the Document Thumbnail 
the Reading toolbar to display thumbnails 
of both pages to view the order of 
scanned pages.    

9. Click on the Table of Contents page
(Page 2) to close Document Thumbnail 
view and display full page view of the 
Table of Contents page. 

10. Then select the Scan, Delete Page menu option.

11. Click Yes in the popup window to delete the 

current page.   

Result: The Summary of Research Front page 

remains in the document area. 

12. Next, scan  in the sample scanning 
pages on pages 130-131, the  Summary 
of Research report.  

 

Follow these steps to insert a page before the current page. 

13. As you learned in Step 6, scanning additional pages are automatically 
appended after the current page. If you want to insert a page before the 
current page, you use the Scan, Insert Page

a. Turn to Page 130 which is titled “Introduction” and pla

scanner. 

14. Make sure you have the page you scanned displayed.

15. Click the Scan, Insert Page menu option

“Introduction page” before the previously scanned final appendix 

page. 

Document Thumbnail icon on 
the Reading toolbar to display thumbnails 
of both pages to view the order of 

Table of Contents page 
(Page 2) to close Document Thumbnail 

nd display full page view of the 

menu option.  

in the popup window to delete the 

The Summary of Research Front page 

 

in the sample scanning 
131, the  Summary 

 

Follow these steps to insert a page before the current page.  

As you learned in Step 6, scanning additional pages are automatically 
appended after the current page. If you want to insert a page before the 

Scan, Insert Page  menu option.  

titled “Introduction” and place it face down on the 

Make sure you have the page you scanned displayed. 

menu option to scan and insert the 

“Introduction page” before the previously scanned final appendix 

 

 



Hands-On Practice - Scanning, Conti

16. Click the Document Thumbnail 

button  to view the three pages 
and review the page order. 

 

Note:  If your page order doesn’t match the thumbnail view above, identify the page 
number that needs to be moved. Next, click on the page that you'd like the 
reordered page to appear. The Thumbnail view closes and you return to full 
page view. Then open the Edit
enter the number of the page to place at your current location and click 
Enter. The page appears before your current page, and is removed from its 
original location. Pages are renumbered to reflect the reordering

 

Follow these steps to save the scanned pages as a .kes image file.

17. The final step in this practice exercise is to save this three
.kes image file. You will use the saved file in the next practice exercise. 

a) Click on one of the pages to return to page view.

18. Select the File, Save  As  menu option and name the file 
Replace xxx with your initials. Notice the file type is automatically assigned .kes.

 
Review the Scanning Options that can be modified to optimize the recog

19. Click the Tools, Options, Scanning

20. Click on Help   and then
scanning option. 

Scanning, Conti nued 

Document Thumbnail 

to view the three pages 

If your page order doesn’t match the thumbnail view above, identify the page 
number that needs to be moved. Next, click on the page that you'd like the 
reordered page to appear. The Thumbnail view closes and you return to full 

Edit menu and choose Move Existing Page, 
enter the number of the page to place at your current location and click 

. The page appears before your current page, and is removed from its 
original location. Pages are renumbered to reflect the reordering. 

llow these steps to save the scanned pages as a .kes image file. 

The final step in this practice exercise is to save this three-page document as a 
.kes image file. You will use the saved file in the next practice exercise.  

to return to page view. 

menu option and name the file xxxScanPractice
with your initials. Notice the file type is automatically assigned .kes.

Review the Scanning Options that can be modified to optimize the recognition quality of a scanned file.

Tools, Options, Scanning  tab to access other scanning options:

 

and then Scanning Basics  to learn more about the 

 

 

If your page order doesn’t match the thumbnail view above, identify the page 
number that needs to be moved. Next, click on the page that you'd like the 
reordered page to appear. The Thumbnail view closes and you return to full 

Move Existing Page, 
enter the number of the page to place at your current location and click 

. The page appears before your current page, and is removed from its 

page document as a 

ScanPractice .  
with your initials. Notice the file type is automatically assigned .kes. 

nition quality of a scanned file. 

tab to access other scanning options: 

to learn more about the 



Document Preparation Toolbar Set

This custom toolbar set provides easy access to proof and editing tools.
accessed through menus and right mouse menu. Display the custom toolbar set by selecting 
Customize, Apply Toolbar Set, Document Preparation

Zone Editing  
Blocks of text on a page (e.g. heading, footers, subtitles, captions, paragraphs) are identified as 
reading zones and assigned a zone number. Zone editing allows you to specify how Kurzweil 3000 
will handle the text.  You can change the reading order of blocks of text, change 
read in a block, eliminate reading for blocks of text, and add new zones to read text that was not read 
previously.  

Correcting OCR errors 
OCR errors include misspellings and disconnected words such as hyphenated words.  Correcting 
OCR errors can be accomplished using the 
options.   

Spell Check  detects spelling errors throughout a multiple page document and allows you to skip 
and/or make corrections in the Spell Check dialog. 

Alternatively, you can correct errors for specific words for one page at a time using the 
OCR menu. 

Document Preparation Toolbar Set  

provides easy access to proof and editing tools. These tools can also be 
accessed through menus and right mouse menu. Display the custom toolbar set by selecting 
Customize, Apply Toolbar Set, Document Preparation . 

age (e.g. heading, footers, subtitles, captions, paragraphs) are identified as 
reading zones and assigned a zone number. Zone editing allows you to specify how Kurzweil 3000 
will handle the text.  You can change the reading order of blocks of text, change 
read in a block, eliminate reading for blocks of text, and add new zones to read text that was not read 

OCR errors include misspellings and disconnected words such as hyphenated words.  Correcting 
rrors can be accomplished using the Spell Check  feature and/or the Edit, Correct OCR

detects spelling errors throughout a multiple page document and allows you to skip 
and/or make corrections in the Spell Check dialog.  

ively, you can correct errors for specific words for one page at a time using the 

 

These tools can also be 
accessed through menus and right mouse menu. Display the custom toolbar set by selecting Tools, 

age (e.g. heading, footers, subtitles, captions, paragraphs) are identified as 
reading zones and assigned a zone number. Zone editing allows you to specify how Kurzweil 3000 
will handle the text.  You can change the reading order of blocks of text, change the amount of text 
read in a block, eliminate reading for blocks of text, and add new zones to read text that was not read 

OCR errors include misspellings and disconnected words such as hyphenated words.  Correcting 
Edit, Correct OCR  menu 

detects spelling errors throughout a multiple page document and allows you to skip 

ively, you can correct errors for specific words for one page at a time using the Edit, Correct 



 Hands-On Practice – Using the Zone Editor

Follow these steps to use the Zone Editor to change reading order in a scanned file. Use the file created 
previous practice named xxxScanpractice.kes (where xxx corresponds to your initials).

1. If not already opened, open the file named 
displayed. 

2. Note : If you didn’t complete the previous exercise, you can open the 
the Kurzweil V10 Training Files folder.
your computer, you can download the ScanPracticeV10.kes from the downlo
Kurzweil web site at: www.kurzweiledu.com/downloads_k3000win.asp.

3. Let’s use the Document Preparation toolbar for easy access to the 
features used in this practice. 

a. Click on Tools, Customize, Apply Toolbar Set to display the list.

b. Click on Document Preparation

4. Now that you have the Document Preparation toolbar displayed, place the cursor at the top of 
Page 3 and click the Read button. 

5. Does Kurzweil 3000 begin reading the first
line of text on the page and so forth which is what you would expect. Sometimes though you 
want to change the reading order of a page and this is accomplished using the Zone Editor. In 
fact, the quickest way to check the order of information that will be read on a page is to use the 
Zone Editor right away.    

Place your 

cursor here   

Using the Zone Editor  

Follow these steps to use the Zone Editor to change reading order in a scanned file. Use the file created 
previous practice named xxxScanpractice.kes (where xxx corresponds to your initials). 

If not already opened, open the file named xxxScanPractice.kes and make sure page 3 is 

If you didn’t complete the previous exercise, you can open the ScanPracticeV10.kes
the Kurzweil V10 Training Files folder.  If you don’t have a Kurzweil V10 training files folder on 
your computer, you can download the ScanPracticeV10.kes from the download page on the 
Kurzweil web site at: www.kurzweiledu.com/downloads_k3000win.asp. 

Let’s use the Document Preparation toolbar for easy access to the 

Click on Tools, Customize, Apply Toolbar Set to display the list. 

Document Preparation  to select it. 

Now that you have the Document Preparation toolbar displayed, place the cursor at the top of 
button.  

Does Kurzweil 3000 begin reading the first line?  Most likely it does and then it reads the next 
line of text on the page and so forth which is what you would expect. Sometimes though you 
want to change the reading order of a page and this is accomplished using the Zone Editor. In 

t way to check the order of information that will be read on a page is to use the 

Follow these steps to use the Zone Editor to change reading order in a scanned file. Use the file created in the 
 

and make sure page 3 is 

ScanPracticeV10.kes in 
If you don’t have a Kurzweil V10 training files folder on 

ad page on the 

 

Now that you have the Document Preparation toolbar displayed, place the cursor at the top of 

 

line?  Most likely it does and then it reads the next 
line of text on the page and so forth which is what you would expect. Sometimes though you 
want to change the reading order of a page and this is accomplished using the Zone Editor. In 

t way to check the order of information that will be read on a page is to use the 



 Hands-On Practice - Using the Zone Editor, Continued
Follow these steps to activate the zone editor, review the reading order and delete a zone.

6. Click Zone Editor  button in the toolbar to activate the zone editor. 

Note:  You can also activate the Zone Editor by selecting it in the Tools menu.

7. Result: Page 3 displays with numbered yellow blocks around text.  The numbers 
indicate the reading order. 

 

 

Numbers 

above the 

yellow 

blocks 

indicate 

the 

reading 

order. 

Using the Zone Editor, Continued  
Follow these steps to activate the zone editor, review the reading order and delete a zone.

button in the toolbar to activate the zone editor.  

ou can also activate the Zone Editor by selecting it in the Tools menu.

Page 3 displays with numbered yellow blocks around text.  The numbers 

Follow these steps to activate the zone editor, review the reading order and delete a zone. 

ou can also activate the Zone Editor by selecting it in the Tools menu.  

Page 3 displays with numbered yellow blocks around text.  The numbers 

 



Hands-On Practice- Using the Zone Editor, Continued
Follow these steps to activate the zone editor, review the reading order and delete a reading zone.

8. The reading order looks okay but the information in zone 11 isn’t important so you 
decide to delete the zone. 

9. 

10. To delete one zone  

a. Click on the 
zone  11 and 
the yellow text 
box turns a 
darker yellow.  

b. Click the right 
mouse button  
to display the 
zone editor 
menu. 

c. Click Delete 
Zone. 

 

 

 

11. Result: The zone box 
disappears and the 
subsequent zones on 
the page are 
renumbered. 

 

13.  

14. Let’s test this change by reading. In order 
you need to deactivate the Zone Editor. 

a. Click on the Zone Editor button
off. 

b. Click OK in the message box to 
the change.  

15. Then place your cursor in the middle of the page and click 
just deleted will be skipped over.

Hands-On Practice – Spell Check the Scanned File

Follow these steps to Spell Check a scanned document to identify and fix recognition errors.

Delete zone 

11 

Using the Zone Editor, Continued  
Follow these steps to activate the zone editor, review the reading order and delete a reading zone.

order looks okay but the information in zone 11 isn’t important so you 

12.  

 

 

Let’s test this change by reading. In order 
you need to deactivate the Zone Editor.  

Zone Editor button  to 

in the message box to 

Then place your cursor in the middle of the page and click Read. The text in the zone you 
just deleted will be skipped over. 

Spell Check the Scanned File  

teps to Spell Check a scanned document to identify and fix recognition errors.

Follow these steps to activate the zone editor, review the reading order and delete a reading zone. 

order looks okay but the information in zone 11 isn’t important so you 

 

 

 

to read, 

turn it 

make 

. The text in the zone you 

teps to Spell Check a scanned document to identify and fix recognition errors. 



1. The Spell Check feature is a useful tool to quickly identify and correct spelling or 
unknown word errors in the underlying text of every page in a scanned document.  
You use Spell Check after zone editing a scanned document.

Using Spell Check, you can skip the word, add it to your personal dictionary, select a 
replacement word from a list of suggestions or type in new text. The changes will 
update the underlying text of the sc

2.  Let’s try Spell Check next with ScanPracticeV11.kes file.

a. Make sure you have page 1 
Spell Check begins spell checking at the cursor.

3. Click the Spell Check icon  on the toolbar to initiate spe

4. Note:  You can also activate it through the Tools, Spell Check menu option.

 

5. Once a misspelled word or a word not in the spell 
check dictionary is detected, the word is 
highlighted and the Spell Check dialog displays.  

a. The first word found is 
a proper noun and not in the dictionary. 

b. Click in the Word box to hear it 
spoken aloud. 

c. Click the Skip  button to skip this instance 
and spell check more of the file. 

6. The next word found is Kurzweil
add it to the dictionary at this point:

a. Click Add  

7. Note:   You might need to move the Spelling 
Correction dialog to see the location of the 
misspelled word 

 

 

Hands-On Practice – Spell Check the Scanned File, Continued

Follow these steps to Spell Check a scanned document to identify and fix OCR recognition errors.

The Spell Check feature is a useful tool to quickly identify and correct spelling or 
unknown word errors in the underlying text of every page in a scanned document.  

Spell Check after zone editing a scanned document. 

Using Spell Check, you can skip the word, add it to your personal dictionary, select a 
replacement word from a list of suggestions or type in new text. The changes will 
update the underlying text of the scanned document 

Let’s try Spell Check next with ScanPracticeV11.kes file. 

page 1 displayed and the cursor is at top of page since 
Spell Check begins spell checking at the cursor. 

on the toolbar to initiate spell checking.   

You can also activate it through the Tools, Spell Check menu option. 

Once a misspelled word or a word not in the spell 
check dictionary is detected, the word is 
highlighted and the Spell Check dialog displays.   

The first word found is Kurzweil  since it is 
a proper noun and not in the dictionary.  

Click in the Word box to hear it Kurzweil  

button to skip this instance 
and spell check more of the file.  

The next word found is Kurzweil again. Let’s 
add it to the dictionary at this point: 

You might need to move the Spelling 
Correction dialog to see the location of the 

Spell Check the Scanned File, Continued  

Follow these steps to Spell Check a scanned document to identify and fix OCR recognition errors.

The Spell Check feature is a useful tool to quickly identify and correct spelling or 
unknown word errors in the underlying text of every page in a scanned document.  

Using Spell Check, you can skip the word, add it to your personal dictionary, select a 
replacement word from a list of suggestions or type in new text. The changes will 

displayed and the cursor is at top of page since 

 

 

Follow these steps to Spell Check a scanned document to identify and fix OCR recognition errors. 



8. Once Page 1 is checked, Spell Check 
moves to Page 2 and detects 
another term not in the dictionary.

a. Click Skip  or Add to move to the 
next word. 

b. Next Assistive is highlighted and 
the Spell Check dialog provides 
several suggestions.

c. Click on each suggestion to hear 
the word spoken aloud.

d. Then click the Add 
Assistive  to the dictionary.

9. To review what words were added to your 
private dictionary, click the 
button.  

10. You can delete the entries by selecting the word 

and clicking the Delete button. 

a. Click OK to close the private 
dictionary. 

11. On Page 3 additional proper nouns and misspellings are identified. You can 
add the proper nouns or skip them. Make any other changes that you think 
are appropriate and then save the changes by saving the file.

 

 

Once Page 1 is checked, Spell Check 
moves to Page 2 and detects NCLB , 
another term not in the dictionary. 

to move to the 

is highlighted and 
the Spell Check dialog provides 

suggestions. 

Click on each suggestion to hear 
the word spoken aloud. 

Add button to add 
to the dictionary. 

To review what words were added to your 
y, click the Dictionary  

You can delete the entries by selecting the word 

 

to close the private 

On Page 3 additional proper nouns and misspellings are identified. You can 
or skip them. Make any other changes that you think 

are appropriate and then save the changes by saving the file. 

 

 

On Page 3 additional proper nouns and misspellings are identified. You can 
or skip them. Make any other changes that you think 



 Hands-On Practice – Edit Underlying Text

Follow these steps to correct a recognition or pronunciation error using the Edit Underlying Tex

1.  As you just learned spell check catches misspelled words and words not in the 
dictionary, but Spell Check doesn’t detect word or characters such as roman 
numerals that might be pronounced different from what you expect even when 
the word image appears correct.  

Some common examples found in the ScanpracticeV11 file on Page 3 include:

a. I pronounced as I rather than One.

b. II pronounced as II rather than Two. 

2. Let’s look at how you would make changes to the underlying text so that the 
information reads correctly 

a. Move to the middle of page 3 of the ScanPracticeV10.kes file

b. Read the sentence that begins with I.

3. Do you hear I read as the letter I rather than the Roman numeral One? 

4. Let’s change the underlying text so that Kurzweil 3000 reads 
the I as One. To view or change the underlying text:

a. Select  the line by clicking and dragging your mouse 
over the phrase. 

b. Click the Edit Text button 
the Edit Underlying Text dialog.

c. Note:   You can also access Edit Underlying Text with 
the right mouse menu or though the Edit menu.

Edit Underlying Text  

Follow these steps to correct a recognition or pronunciation error using the Edit Underlying Tex

As you just learned spell check catches misspelled words and words not in the 
dictionary, but Spell Check doesn’t detect word or characters such as roman 
numerals that might be pronounced different from what you expect even when 

appears correct.   

Some common examples found in the ScanpracticeV11 file on Page 3 include: 

pronounced as I rather than One. 

pronounced as II rather than Two.  

Let’s look at how you would make changes to the underlying text so that the 

Move to the middle of page 3 of the ScanPracticeV10.kes file 

Read the sentence that begins with I. 

Do you hear I read as the letter I rather than the Roman numeral One?  

Let’s change the underlying text so that Kurzweil 3000 reads 
as One. To view or change the underlying text: 

the line by clicking and dragging your mouse 

Edit Text button in the toolbar to display 
the Edit Underlying Text dialog. 

You can also access Edit Underlying Text with 
he right mouse menu or though the Edit menu. 

 

 

 

Follow these steps to correct a recognition or pronunciation error using the Edit Underlying Text feature. 

As you just learned spell check catches misspelled words and words not in the 
dictionary, but Spell Check doesn’t detect word or characters such as roman 
numerals that might be pronounced different from what you expect even when 

Let’s look at how you would make changes to the underlying text so that the 

 

 

 

 

 



 Hands-On Practice – Edit Underlying Text, Continued

Follow these steps to correct a recognition or pronunciation error using the Edit Underlying Text feature.

5. Make the changes so that Part I reads 

a. Click on I to select it.

b. In the Selected Word box, replace I with 
button. 

6. Close the edit underlying text window by:

a. Pressing CTRL + F10 keys together or

b. Click the Edit Underlying Text icon

7. Click OK to save the change to 
underlying text.  

8. Remember to save your changes to the file by clicking the 

9. The final step in this section is to replace the Document Preparation toolbar 
set with the Classic toolbar set.

a. Select Tools, Customize, Apply Toolbar Set, Classic

Result: The classic toolbar set displays.

 

Sample Scanning Pages Next

 

Edit Underlying Text, Continued  

Follow these steps to correct a recognition or pronunciation error using the Edit Underlying Text feature.

Make the changes so that Part I reads aloud as Part One. 

 

to select it. 

In the Selected Word box, replace I with one  and then click the 

 

Close the edit underlying text window by: 

Pressing CTRL + F10 keys together or 

Click the Edit Underlying Text icon 

Click OK to save the change to 

Remember to save your changes to the file by clicking the Save button. 

The final step in this section is to replace the Document Preparation toolbar 
set with the Classic toolbar set. 

Customize, Apply Toolbar Set, Classic 

The classic toolbar set displays. 

Sample Scanning Pages Next

Follow these steps to correct a recognition or pronunciation error using the Edit Underlying Text feature. 

and then click the Read 

 

button.  

The final step in this section is to replace the Document Preparation toolbar 

Sample Scanning Pages Next  
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No Child Left Behind (NCLB), signed into law in January 2002, is considered one of the most significant federal education 

policy initiatives in a generation. Its purpose is to ensure that every student becomes proficient in reading and mathematics 

by 2013-2014. An important aspect of this legislation is to encourage schools to adopt programs, strategies and materials that 

have been researched using rigorous scientific methodology and have proven to be effective. 

 Fortunately, the fruits of over 30 years of research on reading, most of it sponsored by the federal government, are now 

available. While much of the research focuses on the mechanics of reading, the picture that has emerged makes a strong 

case for the use of assistive technology tools such as Kurzweil 3000, or other accommodations, to provide access to content 

while students are receiving explicit instruction in decoding, spelling, and writing. In fact, without this type of accommodation, 

it becomes almost impossible for struggling readers to catch up academically. 

This report provides research validation for the use of assistive technology like Kurzweil 3000 as an important accommodation 

for struggling students.  

The main research findings are summarized below and are followed by a detailed review of the research presented in two 

parts.  

• Part I cites research studies that support the use of tools such as Kurzweil 3000 in the classroom.  

 

• Part II cites research studies that show how specific features of Kurzweil 3000 support important aspects of the 

reading and learning process. 

Synopsis 

• Brain research, using sophisticated imaging technology, has shown that struggling readers actually use different parts of the 
brain when reading. As a result, their brains are less efficient in learning the mechanics of reading. These differences are not 

related to intelligence. Many struggling readers are highly intelligent and have strong cognitive abilities. However, because 

they are unable to master decoding as it’s traditionally taught, they gradually become locked out of much of what is 
happening in the classroom. 

• Research has shown that accurate and automatic decoding frees the competent reader to focus on content. Because reading 
is difficult, struggling readers spend most of their energy trying to decode words with little left to ponder their meaning. Over 

time, their limited exposure to meaningful print impacts the development of vocabulary and background knowledge essential 

for comprehending more advanced subject matter. 

• The middle school curriculum assumes that students can read and write efficiently. However, since struggling readers have 

not yet mastered decoding, spelling, or writing, they are unable to read grade-level materials or express their thoughts in 
writing independently. As a result, they fall further and further behind in their class work. 

• Intensive remediation over time can help these students become better readers, however, unless their vocabulary 

development, background knowledge, and mastery of subject matter keep pace with their peers, they will continue their 
downward spiral.  

Tools like Kurzweil 3000 can make a significant difference in supporting the development of decoding and fluency skills as well as providing 

meaningful access to curriculum materials.  In addition, Kurzweil 3000 helps struggling readers actively engage in the reading process, 

participate more fully in class and keep up with their assignments. Many schools also use Kurzweil 3000 as an accommodation for test 

taking, so students can be evaluated on what they know and not how well they can read and write.  



A comprehensive overview of the government-sponsored research cited in this document can be found in:  

  

Author Title         Source 

National Teaching Children to Read: An Evidenced- National Institute of Child Health  

Reading  based Assessment of the Scientific and Human Development, National 

Panel Research Literature and its Implications Institutes of Health, 2000     for Reading 

Instruction  

 

Part I 

Why Kurzweil 3000 provides essential support to students who are reading significantly below grade 

level 

Some educators are concerned that text readers such as Kurzweil 3000 might become a crutch that prevents struggling 

students from learning how to read and write on their own. Research findings have shown quite the reverse. Assistive 

technology like Kurzweil 3000, for example, not only allows struggling students to read more advanced grade-level material; it 

also helps improve word recognition and decoding. As students using the program become more active readers, they are 

developing the skills that support independent reading without the assistive technology. The research cited below clearly 

demonstrates why providing access to grade-level curriculum content via accommodation is critical to struggling readers’ 

academic success.  

I. Learning differences reflect differences in how the brain processes information 

 

Author Title  SourceSummary 

S. Shaywitz Overcoming Dyslexia   Knopf, New 
York, 2003 

Real differences in the way good readers and 

struggling readers process information make it 

difficult for struggling readers to master 

decoding, spelling, and writing as they are 

traditionally taught. These students learn best 

with instructional methods that simultaneously 

activate different parts of the brain.   

II. Poor reading skills affect all academic areas 

 

Author Title  Source                     Summary 

S. Chall     

V.A. Jacobs 

L.E. Baldwin          

The Reading Crisis: 

Why Poor Children    

Fall Behind 

Harvard University  

Press, MA, 1990 

 

Although many struggling readers 

are of average, or even above 

average intelligence, poor reading 

skills isolate them from their peers 

as well as impact their vocabulary 

development and exposure to 

relevant background knowledge. 

Repeated failure naturally impacts 

motivation and self esteem. 
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